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Part One – ‘How to’ guide for applicants 

Does the Get Started Vouchers pre-requisite apply to you?  
Organisations that provide suitable sport or recreation activities for children and young people 

from the age of five to 17 (inclusive) must be registered for the Get Started Vouchers program to 

be considered eligible for funding under Get Playing Places and Spaces.  

Organisations that do not have junior members or provide activities for these age groups do not 

need to be registered for Get Started Vouchers.  

How to register for Get Started Vouchers, if applicable? 
Go to www.qld.gov.au/recreation/sports/funding/getinthegame/ to register.  

Organisations must be approved by the department as a registered Get Started Vouchers 

organisation before the Get Playing Places and Spaces Round 4 closing date. Registration for 

the Get Started Vouchers may take up to 10 business days to finalise. Please ensure you register 

your organisation well in advance of the closing date for this program.  

Having met the Get Playing Places and Spaces pre-requisite, you are then fine to proceed with 

your application. 

Applying for a Get Playing Places and Spaces grant 
To complete an online application for the Get Playing Places and Spaces program, you will need 

to set up an account in the enQuire system by creating an Applicant Portal account.  

This account can then be used for applying for grants offered by Sport and Recreation Services 
(note – the enQuire database is a separate system to the Get Started Vouchers program 
(QGrants).  A separate account is required for applying for Get Going Clubs. or Get Playing 
Places and Spaces).  
 

Creating an enQuire applicant portal account 
 
You will first enter into the Get Playing Places and Spaces page.  If you click on ‘Begin Application’, 

you will be asked to either ‘Log in or Register’ to continue….’ 

Guidelines reference:  
6.0 Who is eligible to 
apply? 

http://www.qld.gov.au/recreation/sports/funding/getinthegame/
http://www.qld.gov.au/recreation/sports/funding/getinthegame/getplaying/apply/
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 To register for the first time, enter your email address and password (you will need to have 

access to the email address that you enter as an activation email will be sent to it). 

 The password must be at least eight characters long, and use a combination of numbers and 
letters. 
Respond to the question – ‘Are you registering as an individual or an organisation’ by clicking 

the ‘Organisation’ button.  

 

 
 

 Enter your first name and surname and the organisation’s legal name in the bottom section. 
 

 
 

 To review the terms and conditions of using the enQuire system, click on the ‘Terms & 

Conditions’ link.  

 To agree to the terms and conditions for using the enQuire system, tick the box.  

 Click ‘Register’ to finalise the account registration. 



Get Playing Places and Spaces ‘How to’ guide and Troubleshooting manual (enQuire System) 
 

7 
Version 1.0 5 August 2015 

 

 An email with an activation link will be sent to your email address (depending on your security 

settings the email may be sent to your junk folder).  

 You must click on the activation link to activate your account.  

 

Note: Once you have registered and activated the account, select the ‘Login’ option when you 

next use the applicant portal 

(https://portal.enquire.net.au/portal/srp/dashboard.htm#grants:ixd=LTzUMM).  

Create an enQuire applicant portal account (alternative)? 
 Open the applicant portal in your compatible web browser by clicking the following link: 

https://portal.enquire.net.au/portal/srp/dashboard.htm#grants:ixd=LTzUMM. 

 Click on the ‘Log in or Register’ button. 

 

https://portal.enquire.net.au/portal/srp/dashboard.htm#grants:ixd=LTzUMM
https://portal.enquire.net.au/portal/srp/dashboard.htm#grants:ixd=LTzUMM
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Completing the Get Playing Places and Spaces application form  
 The following information will assist you as you complete the online application.  

 

 

Adding attachments in the enQuire system 

As part of completing your application form for the Get Playing Places and Spaces program you 

will also be required to scan documents and upload them. The enQuire system will take any kind 

of attachment that a computer recognises as a file. This will include documents, spreadsheets, 

images and videos.  

The system will not accept any files that are over the 20MB limit, so large files may need to be 

scanned in two parts.    

 

How do I complete the application form? 

 Select the Get Playing Places and Spaces program from the ‘Available grants’ page. 

 

 Read the relevant program information (guidelines). 

 

Guidelines reference: 
Appendix 3 Online 
application form checklist 
and questions 
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 Click ‘Begin Application’.  

 

 

Instructions for completing the application form  

 Read the ‘Instructions on using the form’ before commencing the application.  
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Section 1 – ‘Before you start’ 

 Ensure you read and check that you meet the conditions under the ‘Before you start’ section. 

 

 

 

 

 

Please read all the information, and review the application responses.  

It is possible to partially fill in the application and complete it later. This is done by clicking 

the ‘Save All & Exit’ button. When you log back in you can select the same application under the 

‘My Applications’ tab.  

Note: Once you have submitted your application it cannot be changed.  

When you have completed the application, and you are sure all details are correct, click ‘Submit’ 

to complete the application.  

You can view your application at a later date by clicking ‘My Applications’. 

  

Guidelines reference:  
6.0 Who is eligible to 
apply? 
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Section 2 – ‘Pre-eligibility conditions’ 

 Click on the ‘Edit’ icon to complete the ‘Pre-eligibility conditions’ sections.  

 

 
 

 Select a response to each question to confirm that you are eligible for the program, and then 

click ‘Save’.  

 You will also be required to attach documents. To do this, select ‘Choose file’ and then click 

on relevant file. When you see Max 20MB per attachment, this enables you to save more than 

one attachment. 

 Please note that the organisation must be compliant with all requirements to be eligible for the 

program.  Organisations will be deemed ineligible if they do not meet one or more of the 

eligibility requirements. 

 Some sections of the application form have mandatory questions.  If these questions are not 

responded to, you will not be able to save the section.  If you do not have all information 

available, then select cancel, and save the application so you can complete this section at a 

later date (prior to the program closing date). 
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When you see Max 20MB per attachment, you can save more than one attachment. 

 

Guidelines reference:  
10.0 Eligibility 
requirements 
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 If you have added an incorrect attachment you are able to delete and replace with a new one. 

You will need to click on the edit icon to open the section. 

 

 You will need to select the attachment that is to be replaced. Select choose a file and attach 

the correct attachment. When you press ‘save’ on the section this will remove the ticked 

attachment. 

 

Section 3 – ‘Organisation details’ 

 Complete the ‘Organisation details’ section.  

 Details in regards to the legal organisation, the ABN, address details and accountable officer 

details (i.e. President or Chair) will need to be included. 
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 Use the ‘Person’, ‘Edit’ or ‘Add’ icons to update the details of the organisation, accountable 

officer and main contact person for the project.  

 Click ‘Save’ when complete. 

 

 When editing or adding the organisation details ensure ‘Organisation / Company’ is selected 

under type. 

 

 Enter all the relevant fields. 
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 If your Mailing Address is the same as your Physical Address you can click ‘Copy address 

details from above’.  

 

 

 When editing or adding the ‘Accountable officer’ or additional ‘contact people’ ensure 

‘Individual / Employee / Person’ is selected under type. 
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 Complete the required fields and click ‘Save’ – you will need to complete the ‘Mailing Address’ 

fields or click ‘Copy address details from above’.  

 Enter all the relevant fields (noting that some are mandatory, as indicated by an asterisk). 
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 Click the ‘Organisation Details – Get Playing’ to select the Act that your organisation is 

incorporated under and enter the organisations incorporation number/ Australian company 

number. 

 Complete the required fields and click ‘Save’ 
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Section 4 – ‘Project details’ 

 Enter the project description by clicking the ‘Edit’ icon. The summary should be approximately 

250 words, and a short description of the project components. 

 You will also be required to attach documents. Select ‘Choose file’ and click on the relevant 

file. 

 

 

 Enter the ‘Organisation legal name’ and click ‘Save’. 

 

 Enter the ‘Project description’ and click ‘Save’. 

 

 Complete the physical address of the project and click ‘Save’. 

 

 Click the ‘Project details - Get Playing’.  

 You will also be required to attach documents. Select ‘Choose file’ and click on the relevant 

file. 

 Complete the required fields and click ‘Save’. 
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Section 5 – ‘Need’ 

 Complete the ‘Need’ section by clicking the ‘Edit’ icon, and then ‘Save’.  

 You will also be required to attach documents. Select ‘Choose file’ and click on the relevant 

file. 

 

 

 

Guidelines reference:  
14.0 Need 
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Section 6 – ‘Ability to deliver’ 

 Complete the ‘Ability to deliver’ section.  

 You will be required to click on the ‘Project plan and Project costs’ spreadsheet and save the 

document to your computer.  

 

 

Guidelines reference:  
14.2 Ability to deliver 
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 Open the document you have saved and complete the table. Save this file as it will need to be 

uploaded later in the application.  
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 Complete the ‘Ability to deliver’ section by clicking the ‘Edit’ icon.  

 You will also be required to attach documents. Select ‘Choose file’ and click on the relevant 

file. 

 

 When you get to the ‘Download and complete the Project plan and project costs tables to 

identify project costs, in-kin and financial contributions question’ select ‘Choose file’ to attach 

the table you downloaded and completed.   
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 Complete the remaining questions in ‘Ability to deliver’ and click ‘Save’. 
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Section 7 – ‘Declaration’ 

 

 Read the declaration section and click ‘Edit’ to complete the section.  

 

 Select the relevant response and click ‘Save’ to complete the declaration.  
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Section 8 – ‘Feedback’ 

 Provide feedback by clicking the ‘Edit’ icon. 
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Before you submit 

Please read all the information. If you are sure all details are correct, click ‘Submit Application’ to 

complete the application.  

Note: Once you have submitted your application it cannot be changed.  

It is possible to partially fill in the application and complete it later. This is done by clicking the 

‘Save All & Exit’ button. When you log back in you can select the same application under the ‘My 

Applications’ tab.  

You can view your application at a later date by clicking ‘My Applications’. 
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Saving a copy of your application 
At the end of the application process, you will receive a PDF version of your application, which 

can be printed or saved if you wish. The details will also remain on the enQuire system which you 

can access when you log in. 

 

 

 

 

Now that you are registered, just select the ‘Log In’ option when you next use enQuire. 

 

 
What if your organisation is unable to complete an online application?  
If the organisation does not own or have access to suitable computer systems or the internet to 
complete an online application, contact your nearest Sport and Recreation Services office. 

 
What if your organisation would like to withdraw an online application?  
If, for some reason, your organisation would like to withdraw your application, you cannot do this 
via the enQuire system. Please contact your nearest Sport and Recreation Services office to 
discuss the withdrawal. Arrangements will then be made to have the application removed from 
the enQuire system.  
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Part Two – Trouble Shooting  

Browser or compatibility issues 

Are you using a mobile or tablet device? 
The enQuire system is NOT compatible with mobile or tablet devices.  Any online applications 

must be made from a PC. 

 

 

What kind of browser are you using? 
To assist with any queries and to diagnose problems, it may be necessary to confirm what 
internet browser is being used and its version number. Details on how to do this follow.  
Where the enQuire site is not being displayed, first check if you are using a browser from the 
following list (please note: earlier versions of the below should support the enQuire site but have 
not been as thoroughly tested):  

 Google Chrome (Windows, Android and Mac OS X) 

 Mozilla Firefox (Windows and Apple OS X) 

 Microsoft Internet Explorer 8, 9, 10, 11 (Windows) 

 Safari (Apple iOS 7.1.1). 
 

 

You are using Internet Explorer 

 

You are using Google Chrome 

 

You are using Mozilla Firefox 

 

You are using Safari 

http://help.enquire.net.au/FAQ-Browser%20Version.htm
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enQuire may work on Linux or Ubuntu operating systems, but this has not been tested and is not 
supported. 

Are you unable to view the enQuire website due to compatibility view and 
rendering errors? 
To see if there is a compatibility view error, do the following: 

 select Tools at the top of the browser (or if this does not appear, press Alt and T) 

 select Compatibility View Settings 

 in the box under Add this website type in enquire.net.au  

 Click Add 

 Click Close. 
 
A rendering error message is an error with Internet Explorer. If this occurs, please download 
Google Chrome at www.google.com/intl/en/chrome/ and use this browser to log into the enQuire 
account. 
 
To assist with queries and diagnose problems with performance, the internet browser version 
number may be required. Follow the instructions below on how to check which version is 
installed.  
 

How do I confirm the internet browser version number? 
 
Internet Explorer 
 Open Internet Explorer. 

 At the top of the Internet Explorer window, select Help and then select About Internet 
Explorer. If the Help option is unavailable, press Alt on your keyboard. 

 

 If you have a more recent version of Internet Explorer, select Tools (cog icon) in the top right 
corner, then select About Internet Explorer. 

http://www.google.com/intl/en/chrome/
http://help.enquire.net.au/FAQ-Browser.htm
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 In the window that appears, the major and update versions will be listed. 

 

More information is available via the Microsoft Support Centre. 

Google Chrome 
 Open Google Chrome. 

 In the top right corner, select either Tools or Settings (wrench or menu icon), and then select 
About Google Chrome. 

 

 The version number will appear in a new window or tab. 

http://windows.microsoft.com/en-AU/internet-explorer/which-version-am-i-using/
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More information is available from the Google Support Centre. 

Mozilla Firefox 
 Open Mozilla Firefox. 

 At the top of the Firefox window, select Help and then select About Mozilla Firefox. If the 
Help option is unavailable, press Alt on your keyboard. 

 

 If you have a more recent version, open the menu in the top right hand corner, and then 
select the Help Menu (question mark icon). You will then need to select About Mozilla 
Firefox. 

 

 In the window that appears, the version number will be listed. 

https://support.google.com/chrome/answer/95414?hl=en-GB
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More information is available from the Mozilla Firefox Support Centre. 

Safari 
 Open Safari. 

 Select Safari, and then select About Safari. 

 

 In the window that appears, the browser version number will be listed. The first number is the 
major version of Safari, and the number inside the parenthesis is the build number. 

 

https://support.mozilla.org/en-US/kb/find-what-version-firefox-you-are-using
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Account log in or registration issues 

Authorisation to make the application. 
Make sure you are authorised to complete the application form on behalf of your organisation. 
You will also need details of the organisation’s accountable officer. The accountable officer is the 
person in your organisation who correspondence will be sent to, so it is important to have this 
entered correctly.   

Which email address do you use?  
You can use a personal email address, or a club email address if available (preferred) to register 
on the applicant portal. Whichever email address you register with, it must be one that you have 
ongoing access to. For example, an activation link will be sent to the email address provided.   
 

Some other basics at a glance  
 

 Contact the nearest Sport and Recreation Services office to discuss your project and 
application prior to submitting the online application form. 

 Please contact your regional advisor initially if you need help registering online or 
completing the online application form. 

 Issues with applying online may occur due to restrictions on home/office computers, 
browsers used – further details are provided in this document.  

 Using Firefox and/or Chrome as your browser for the application process ensures 
compatibility.  

 The enQuire system is NOT compatible with mobile or tablet devices. Any online 
applications must be made from a PC. 

 Use the correct legal name of the organisation as per OFT certificate of incorporation, 
Australian Company name (ASIC). 

 Provide full and accurate project location address and organisation address.  If using 
parks, reserves etc., there must AT LEAST be a correct street address and suburb. 

 You can copy and paste from a word file into the online application fields for ease of data 
entry. 

 Ensure you save each section of the online application.  

 Some online applications will require the applicant to download and upload documents.  If 
prompted to download a document, make sure you save it on your PC along with any 
information you have added before uploading.  

 Only click ‘Submit’ when your application is completely finalised, as changes cannot be 
made afterwards. Note: There is an option to save a partially completed application and 
return to it later.  

 Colours of the application form online may appear different due to the user’s monitor 
setup. 

 

Have you entered your email address correctly? 
Check your email address was entered correctly. If the email address used to register with was 
incorrect, you will not receive a validation email and will be unable to log in to your enQuire 
account.  

 
If you think you entered an incorrect email when first registering, please email 
SRSGrants@npsr.qld.gov.au for further assistance.  
 

mailto:SRSGrants@npsr.qld.gov.au
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Are you entering a password with the required number of characters and 
numbers? 
Check the entered password is at least eight characters long, and uses a combination of 
numbers and letters. 

Have you activated your account by clicking on the validation link? 
You will be unable to log in to your enQuire account if you attempt to log in prior to receiving the 
validation email and activating your account.  
 
You should receive your validation email within 15 minutes of registering your account. If there 
are a high number of system users at the time, there may be a delay in receiving the email due to 
the number of email servers it has to pass through. Please note: Sport and Recreation Services 
has no control over this.  
 
If you have not received the validation email, please check your junk mail. 
 
Some email addresses will not work. For example, if you are registering with a work email and 
your employer’s IT security blocks the email. In this situation, you should try and re-register using 
another email address.  
 
If the validation email has still not been received after an hour, please email 
SRSGrants@npsr.qld.gov.au for further assistance. Please include the following information: 

 What email client you are using (e.g. Microsoft Outlook, gmail, Hotmail etc.) 

 What web browser you are using (e.g. Google Chrome, Firefox, Internet Explorer).  

 What security software your computer is running.  

 Any screen shots of errors if possible.  
 

If you have not received a registration confirmation email with the activation 
link? 

 Log in to the portal.  

 This will prompt the system to re-send the activation link to your email.  

 Check your email including junk mail folder. Click on link to activate your account. 

 If email has still not been received, please email SRSGrants@npsr.qld.gov.au.   
 

Forgotten your password, or received an ‘invalid email or password’ message? 
If you have forgotten your password, or received an ‘invalid email or password’ message, you can 
generate a new password in the enQuire system yourself. 

1. Select the Forgot your password? link under the log in area of enQuire. 

 

mailto:SRSGrants@npsr.qld.gov.au
mailto:SRSGrants@npsr.qld.gov.au
http://enquire.net.au/
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2. Then enter either your user identification (id), or email address and select Continue. 
3. An email will be sent to your email address with your user id and temporary password. You 

will be prompted to change this password the next time you log in to enQuire.  
4. Email SRSGrants@npsr.qld.gov.au if you cannot reset you password.  

Having trouble with attachments or PDFs? 

 Be careful saving files on the computer being used. It is recommended the ‘Save As’ 
function is used and the file is saved in a known location.  

 If user clicks ‘Save’ the file may be filed into the temporary files on the computer being 
used 

 Temporary files are located on the c: drive of the computer being used (e.g. 
C:\Users\halema\AppData\Local\Temp) 

 

 

 

Trouble opening the Excel application attachment?  
Mac Users Version Compatibility (Numbers for Mac) 
Numbers for Mac is compatible with Microsoft Excel. Save numbers spreadsheets as Excel files. 

Further information on compatibility can be found online:  

https://www.apple.com/mac/numbers/compatibility/ 

 
Microsoft Excel Version Compatibility 
It is recommended that you use Microsoft Excel 2010 or later. Information on your version can be 

found online:  https://support.office.com/en-us/article/What-version-of-Office-am-I-using-

932788b8-a3ce-44bf-bb09-e334518b8b19. 

 

mailto:SRSGrants@npsr.qld.gov.au
https://www.apple.com/mac/numbers/compatibility/
https://support.office.com/en-us/article/What-version-of-Office-am-I-using-932788b8-a3ce-44bf-bb09-e334518b8b19
https://support.office.com/en-us/article/What-version-of-Office-am-I-using-932788b8-a3ce-44bf-bb09-e334518b8b19
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Trouble opening the PDF version of the application?  
At the end of the application process, you will receive a PDF version of your application, which 

can be printed or saved if you wish. The details will also remain on the enQuire system which you 

can access when you log in. There may also be other information in enQuire, such as a Facts 

Sheet that can help you.  These are available in the ‘Help’ section of the portal.  

Out-of-date or incompatible PDF reader? 

Issues opening a PDF may be due to your PDF reader being incompatible, or out of date. Adobe 
Reader version 9 or higher is required by enQuire. You can download the latest version of Adobe 
Reader for free at http://get.adobe.com/reader/. Other Windows based PDF readers are not 
supported. 

 
Is Acrobat JavaScript enabled? 
You can check if this is the problem by doing the following:  

 Open Adobe Reader from the desktop or start-bar menu   

 Click Edit and selecting Preferences  

 Select JavaScript from the Categories and tick the checkbox to Enable Acrobat 
JavaScript  

 Click OK to close the Preferences window  

 Close Adobe Reader by clicking File and selecting Exit  

 Re-open the web browser and continue to use enQuire. 

 
Is Adobe Reader set to display PDFs in a web browser?   
You can check if this is the problem by doing the following:  

 Open Adobe Reader from your desktop or start-bar menu 

 Click Edit and selecting Preferences  

 Select Internet from the Categories and tick the checkbox to Display in Read Mode by 
default 

 Click OK to close the Preferences window 

 Close Adobe Reader by clicking File and selecting Exit  

 Re-open the web browser and continue to use enQuire.  

 
Do you have Kapersky Anti-virus software?   
If you have Kapersky anti-virus software, a blank page will be displayed when you attempt to 
open a PDF. Disabling the anti-virus software in this case will not rectify the issue. You will need 
to download a different browser. For example, if you are using Internet Explorer you should try to 
log in to your enQuire account using a different browser, such as Google Chrome. You can 
download Google Chrome for free through the following link:  
https://www.google.com/intl/en_au/chrome/browser/desktop/index.html 

 
Adobe Reader  
The operation of Adobe Reader is affected by certain ‘add-ons’. It is recommended users enable 
Adobe Reader add-ons for the PDF copy of your application to display and function correctly.  
 

Disabling virus add-on/s in Internet Explorer  
Go into the Internet Explorer browser and do the following: 

 Select Tools, and then Manage add-ons 

 Select the add-ons that are listed under the Adobe Systems Incorporated heading  

 Enable the add-on/s by selecting Enable (for one add-on), or Enable all (for multiple add-
ons)  

http://get.adobe.com/reader/
https://www.google.com/intl/en_au/chrome/browser/desktop/index.html
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 Select any add-ons that mention anti-virus and then select Disable (for one add-on) or 
Disable all (for multiple add-ons) and then Close. 
 

Disabling virus add-on/s or ‘extensions’ in Google Chrome  
Go into the Google Chrome browser and do the following: 

 In the address bar type chrome://extensions  

 Un-tick Enabled next to the anti-virus name (could be multiple entries).  
 

Disabling virus add-on/s in Mozilla Firefox  
Go into the Mozilla Firefox browser and do the following: 

 In the address bar type about:addons  

 Go to the Extensions tab 

 Click the Disable button next to the anti-virus name (could be multiple entries).  

Still unable to find the answer to the issue? 

Still experiencing technical issues during the application process?  
If you are still experiencing technical issues during the application process, you should close all 
windows, Log Out and Exit out of your enQuire account. If you only Log Out it may take you 
back to where the technical error occurred.  
 

When all else fails?  
If you are still experiencing issues using enQuire, please email SRSGrants@npsr.qld.gov.au, 
providing the following information:  

 The operating system you are using (i.e., Windows XP, Windows 7, Mac OS X, etc.)  

 The browser and it’s version (click on Help > About in most browsers)  

 Which anti-virus (if any) you are using  

 Time at which the error occurred  

 If you are having issues with any other websites  

 Any error messages you have encountered (please include a screenshot if possible).  
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